SAM4S

SAMA4S Receipt Printer

Unless otherwise specified, the document is printed or copied document are not controlled



Contents

Table of Contents
Table of Contents.......ccccvveeerrinnes

© N ok~ w N RE

Introduction.........ccoceeuenneene
Overview .......cccovivinerininnne,
Prerequisite......cccccveeeerunneenn.
Extracting files using GUI ...
Installation Wizard .............
Add / Delete a JPOS Device
Sample Application Code...

Uninstallation Procedure...
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Introduction

The purpose of this document is to describe how to install and use the SAMA4S Receipt
printer JPOS driver for Linux, in detail. The document provides information on installation
and using of SAM4S Receipt Printer JPOS Set driver on Ubuntu 12.04, 12.10, 13.10 (32 bit
and 64 bit) operating systems.

Overview

SAMA4S Receipt printer JPOS driver for Linux can support thermal receipt printing of text,
image and bar-code along with Cash drawer functionality.

Prerequisite

SAMA4S Receipt printer JPOS driver with Linux support and has been tested on the
following distributions of Linux:
= Ubuntu 12.04, 12.10, 13.10 32 bit
= Ubuntu 12.04, 12.10, 13.10 64 bit
Also requires JDK 1.7 & JRE 7 needs to be pre-installed
1. Steps to install JRE through GUI

= Click on the Ubuntu Wubi [Marked as red in the image below] icon which is on the
top right of the menu and type in Ubuntu Software Center and click Ubuntu

Software Center Link from the dashboard.
(=]

é <1 ® ubuntu Software Center

Hi Applications

Ubuntu Software
Center
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= In the opened Ubuntu Software Center enter Java in search box and select

OpenJDK Java 7 Runtime from the list as shown in the following screen to install

the OpenJDK Java 7 Runtime.

-

Installed

%

All Software

C

All Software

DClock 7 (5)
Digital Desktop Clock Application

OpenJDK Java 7 Runtime (52)
OpenJDK Java 7 Runtime

OpenJDK Java 6 Runtime (60]
OpenJDK Java 6 Runtime

Icedtea Java Plugin {49)
lcedtea Java Browser Plugin

IcedTea Java Web Start (17)
lcedTea Java Web Start

Visualvm ¢ | [6)
All-in-One Java Troubleshooting Tool

NetBeans IDE 7.0.1 (118)
Integrated Development Environment

Robocode i (12)
Java programming game based on battle tanks

B O~ B KB B«

2. Steps to install JRE through Terminal

= Launch the Ubuntu Terminal

| ByRelevance v |

= Type the following command to install the OpenJDK Java 7 Runtime.

sudo apt-get install openjdk-7-jre

Extracting files using GUI

To install this SAM4S Receipt Printer JPOS Driver version xx.xx.xx.xx for Linux by means of

GUI, the user needs to be a root user.
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= Click on the SAM4S_Receipt_Printer_JPOS_Driver-x.x.x.X-Linux-x86_64-Install.tar.gz or
SAMA4S_Receipt_Printer_JPOS_Driver-x.x.x.x-Linux-x86-Install-Install.tar.gz archive file to
untar 64 bit or 32 bit driver installer respectively to a desired directory location.

[In the fire fox web browser, the setup will be downloaded inside the download folder. Right
click = Open Containing folder = Right click 2 Open with Archive Manager - Right click
Extract or click Extract = select the desired location = Click Extract]

= Switch to the directory location where the setup has been un tared and double click on the
binary to install the driver.

5. Installation Wizard

Prerequisite:

The installation can be performed only in Administrator mode. Type the Administrator
password [sudo user] when prompted.

= Double click on the un-tared binary to initiate the installation of the driver.
= To install the driver, click Yes in the screen displayed after the user double clicks the driver

setup. On clicking Yes the SAMA4S Receipt Printer JPOS Driver Setup wizard’s  Welcome
screen for installation appears. Click No on the same screen to cancel the installation.

™ Install SAM45 JPOS Driver A

@ Thiz will install SAM4S JPOS Driver on your computer, Continue?

Hao

= In the SAMA4S Receipt Printer JOS driver Welcome Page shown below. Click on Next to
continue with the installation or, Click on Cancel to terminate installation.
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SAM4S JPOS Driver Setup

Welcome to the Installlammer Wizard for
SAMAS JPOS Driver

This will install SAM4S JPOS Driver
versgion 1,0,0,4 on your computer,

It i= recommended that you close all
other applications before continuing,

Click Mext to continue or Cancel to exit
Setup,

i MNext > ]| Cancel |

= Click Next on the Welcome screen to navigate to Start Coping Files screen as shown below
or, Click on Cancel to terminate installation.

SAM4S JPOS Driver Setup

Start Copying Files A ‘

Review settings before copying files

Setup haz enough information to start copying the Eragram file=z,
If you want to review or change an? zetting=s, click Back, If you
are zatizfied with the settings. click Mext to begin copying files,

Install Directory: bt
Ausrd local ASAMAS JavaPosDr iver
Setup Tuype:
Typical
il I [

Inztalllanner

| < Back |E Mext > 1 | Cancel |
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= The next screen will display the progress of the installation process. After the installation is
complete the Next button will be enabled.

= Now all files will be copied in to the directory
1. /usr/local/SAM4SJavaPosDriver

= After copying is complete, the final Install Jammer Wizard finish page will show the
message successfully installed SAMA4S Receipt Printer JPOS Driver.

SAMAS JPOS Driver Setup

InstallJammer Wizard Complete

The InstallJammer Hizard has
successfully installed SAM4S JPOS
Oriwer, Click Finish to exit the
wizard.

[ Einish 7§ [ Cancel

= Click on Finish button in the Install Jammer Finish page to complete the installation and
exit the Installer.

6. Add / Delete a JPOS Device

3. Add a JPOS Device

= Launch the JPOS Set application for SAMA4S Receipt Printers by Click on the Ubuntu
Wubi [Marked as red in the image below] icon which is on the top right of the menu
and type in SAM4S JavaPOS Application and click SAM4S JavaPOS Application link
from the dashboard.
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@

® - | ® SAM4s JavaPos Application|

ki Applications

\Z

SAM4S JavaPOS Uninstall SAM4S
Application JavaPOS Application

= Click the file menu and select the Add Device option from the following screen to add
the new JPOS device.

: SAM4S JPOS Set

File Tools Help

=R v

D POS Printer Device Name Device Description Status

=g

= Then select the POS Device option then click Next button, Next screen will show the
available communication type and model names of the printer.
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Add New Device

JP0OS DRIVER INSTALLER

Select a Device Class

|POS Printer

SAM4s

Next > || Cancel

Add New Device

Add New Device

Communication Setting

Select Device Name Port
[ELLIX40 [~ Baiidrate (B Ea00 :
Select Communication Type parity
|SERIAL [~]
—
AMGS stoppt 7
Add New LDN

A logical device name isn't indispensable.
A logical device name isn't set up in the case as the blank.

| < Back || Next > || Cancel |

= Then select the appropriate communication type and their communication settings as
well as logical device name to the POS device to add as shown in the above screen.

= Then it will ask the confirmation; click Yes to add the install the JPOS driver for the
device.

? Do you want install this JPOS driver?

Yes | No
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= Then following screen will show the installed POS device and their corresponding LDN

SAM4S JPOS Set

File Tools Help

il | ~
=RV
¢ CJPOS Printer Device Mame | Device Description | Status
[ ELLixd0 - 1 [ELLXA0 -1 ELLIX40 - SERIAL Standalone
4. Add LDN

= To Add LDN, select the JPOS device from the device Tree then click the File
menu and select Add LDN, the following screen will appear
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Device Info
" :
nM s DEVICE CLASS: POS Printer
DEVICE MAME: ELLIX40 -1

Add New LDN

A logical device name isn't indispensable.
A logical device name isn't set up in the case as the blank.

| 0K H Cancel

= Enter the Logical Device Name not more than 15 characters and click OK.

5. Delete LDN

= To delete any LDN, select the LDN either in Tree or Grid view and click either
Delete icon from the toolbar or select Delete LDN from the File menu.

6. Test JPOS Device

= In order to test the POS device LDN, click the Tools menu and select the Device Test
option. Then following screen will appear.
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Device Test

DEVICE LDN TEST

P0S Printer Test
DEVICE STATUS Idle

‘ Open H Claim H Release H Close

[] Device Enabled []JAsync Mode []Transaction

SAmSs

Print Text | [~]
| Print Immediate | | Cut Paper | | Print Barcode |
| Print Normal | | Feed and Cut | | Print Image |

| CheckHealth Interactive || oK |

= In the Device Test window first click the Open then Claim button. The following screen
will appears.

Device Test

DEVICE LDN TEST

POS Printer Test
DEVICE STATUS  Opened/Enabled

‘ Open ‘ ‘ Claim ‘ ‘ Release ‘ ‘ Close

Device Enabled [ ]| Async Mode []Transaction

SAmSs

N

Print Text | | | ]

| print immediate | | cutPaper || Print Barcode |
| printnormal || Feedandcut ||  printimage |

| CheckHealth Interactive || 0K |

= Select the Device Enabled check box in order to test the device as shown in the above
screen
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= To print text immediate or normal, enter the text in Print Text text box and click either
Print Immediate or Print Normal respectively.

= To printimage, click the Print Image button and select any bmp file.

= To test cut paper option, click Cut Paper button.

= To test feed and cut option, click Feed and Cut button.

7. Device Configuration

We can able to change the device configuration of the selected LDN.

= To edit the configuration of the LDN, select any LDN and then click the Tools menu and
select the Device configuration option, then following screen will appear.

Device Configuration

Communication Setting

Select Communication Type | | |

S . g 1 M
AM4S
Baudrate 115200 =]
Parity INONE |
Databits IB |v|
Stopbit i |'|
| Apply || cCancel

= Make necessary changes to the communication settings and click Apply button to save
the changes.
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8. Delete a JPOS device

= To delete a JPOS device select the device either in Tree or Grid view and click
either Delete icon from the toolbar or select Delete Device from the File menu.

7. Sample Application Code

Sample application will demonstrate on how to program various receipt related
functions such as composing text and images, aligning text and images, print, barcode,

cash drawer open using JPOS driver.

Following are the steps to open SAMA4S Receipt printer JPOS sample application code

directory

= Click on the Ubuntu Wubi [Marked as red in the image below] icon which is on the top
right of the menu and type in SAM4S and click the “SAM4S JavaPos Code Sample” Link

from the dashboard.

ki Applications

| ; L3 ’
SAM4S JavaPOSs Uninstall SAM4S SAMAS JavaPOSs Code

Application JavaPOS Application Sample

[ Files & Folders see

1 I
E 10
101

1010

Desktop Downloads img 21-5AM45-USB-

Printer.rules

= Code Sample directory will open as shown in the following screen
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CodeSample = Bt 4 6:34PM R test {%

@ Devices B usr local SAMA4SJavaPosDriver CodeSample
2 1.0GBFilesy...
Pre B

(3 ¥ L[ 20GBFilesy... =
B 2 1.0GBFilesy... j J L1

C++ Java ReadMe.txt

£110GBFilesy...

- i 2 10 GB Filesy...

3 1.0GBFilesy...

£110GBFilesy...
é Computer
] | Home b
K Desktop

i Documents
|l Downloads

i Music
[ Pictures
L=J [l videos
-— ~ File System
E & Trash
Network

i Browse Net...

8. Uninstallation Procedure

Following are the steps to uninstall SAM4S Receipt printer JPOS driver from the Linux
system

= Click on the Ubuntu Wubi [Marked as red in the image below] icon which is on the top
right of the menu and type in Uninstall SAMA4S JavaPOS Application and click Uninstall
SAMA4S JavaPos Application” Link from the dashboard.
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=]

® - | ® Uninstall SAM4S JavaPOS Application

ki Applications

Uninstall SAMA4S

JavaPOSs Application

= Type the root password when root access windows shown to open the Uninstall wizard.

™ Uninstall SAM4S JPOS Driver

@ Thiz will completely remove SAMAS JPOS Driver from your system, Are you sure you want to do this?

| Tes ]| Mo |

= Uninstall confirmation message will be shown as above, click Yes to uninstall the JPOS
driver or click No to terminate the uninstallation.
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SAMAS JPOS Driver Setup

Uninstall Complete

SAMAS JPOS Driver has besn removed from
your system,

FFinish ) | Cameel |

= The above screen will be shown on successful uninstallation of JPOS driver from the
system.
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